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Chapter 1 — Routing Concepts
1.0.1.2 Class Activity— Do We Really Need a Map?

Objectives

Describe the primary functions and features of a router.

Scenario

Using the Internet and Google Maps, located at http://maps.google.com, find a route between the capital city
of your country and some other distant town, or between two places within your own city. Pay close attention
to the driving or walking directions Google Maps suggests.

Notice that in many cases, Google Maps suggests more than one route between the two locations you chose.

It also allows you to put additional constraints on the route, such as avoiding highways or tolls.

» Copy at least two route instructions supplied by Google Maps for this activity. Place your copies into a
word processing document and save it for to use with the next step.

*  Open the .pdf accompanying this modeling activity and complete it with a fellow student. Discuss the
reflection questions listed on the .pdf and record your answers.

Be prepared to present your answers to the class.

Resources

e Internet connection
e Web browser

e Google Maps, http://maps.google.com/

Reflection

1. What do the individual driving, or walking based on your criteria you input, and non-highway directions look
like? What exact information do they contain? How do they relate to IP routing?
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2. If Google Maps offered a set of different routes, what makes this route different from the first? Why would you
choose one route over another?

3. What criteria can be used to evaluate the usefulness of a route?

4. s it sensible to expect that a single route can be “the best one”, i.e. meeting all various requirements? Justify
your answer.

5. As a network administrator or developer, how could you use a network map, or routing table, in your daily
network activities?
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1.1.1.9 Lab — Mapping the Internet

Objectives
Part 1: Determine Network Connectivity to a Destination Host

Part 2: Trace a Route to a Remote Server Using Tracert

Background / Scenario

Route tracing computer software lists the networks that data traverses from the user’s originating end device
to a distant destination device.

This network tool is typically executed at the command line as:
tracert <destination network name or end device address>
(Microsoft Windows systems)

or
traceroute <destination network name or end device address>
(UNIX, Linux systems, and Cisco devices, such as switches and routers)

Both tracert and traceroute determine the route taken by packets across an IP network.

The tracert (or traceroute) tool is often used for network troubleshooting. By showing a list of routers tra-
versed, the user can identify the path taken to reach a particular destination on the network or across inter-
networks. Each router represents a point where one network connects to another network and through which
the data packet was forwarded. The number of routers is known as the number of hops the data traveled from
source to destination.

The displayed list can help identify data flow problems when trying to access a service such as a website. It
can also be useful when performing tasks, such as downloading data. If there are multiple websites (mirrors)
available for the same data file, one can trace each mirror to get a good idea of which mirror would be the
fastest to use.

Command-line based route tracing tools are usually embedded with the operating system of the end device.
This activity should be performed on a computer that has Internet access and access to a command line.

Required Resources

PC with Internet access

Part 1: Determine Network Connectivity to a Destination Host

To trace the route to a distant network, the PC used must have a working connection to the Internet. Use the
ping command to test whether a host is reachable. Packets of information are sent to the remote host with
instructions to reply. Your local PC measures whether a response is received to each packet, and how long it
takes for those packets to cross the network.
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a. Atthe command-line prompt, type ping www.cisco.com to determine if it is reachable.

C:\>ping www.cisco.com

Pinging el144 . dscb.akamaiedge.net [23.1.48.170] with 32 bytes of data:
Reply from 23.1.48.170: bytes=32 time=56ms TTL=5T7
Reply from 23.1.48.170: bytes=32 time=55ms TTL=5T7
Reply from 23.1.48.170: bytes=32 time=54ms TTL=57
Reply from 23.1.48.170: bytes=32 time=54ms TTL=5T7

Ping statistics for 23.1.48.170:

Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milli-seconds:

Minimum = S4ms, Maximum = 56ms, Average = Sims

b. Now ping one of the Regional Internet Registry (RIR) websites located in different parts of the world to
determine if it is reachable:

Africa: www.afrinic.net

Australia: www.aphnic.net

South America: www.lacnic.net

North America:  www.arin.net

Note: At the time of writing, the European RIR www.ripe.net does not reply to ICMP echo requests.

The website you selected will be used in Part 2 for use with the tracert command.

Part 2: Trace a Route to a Remote Server Using Tracert

After you determine if your chosen websites are reachable by using ping, you will use tracert to determine
the path to reach the remote server. It is helpful to look more closely at each network segment that is crossed.

Each hop in the tracert results displays the routes that the packets take when traveling to the final destina-
tion. The PC sends three ICMP echo request packets to the remote host. Each router in the path decrements
the time to live (TTL) value by 1 before passing it onto the next system. When the decremented TTL value
reaches 0, the router sends an ICMP Time Exceeded message back to the source with its IP address and the
current time. When the final destination is reached, an ICMP echo reply is sent to the source host.

For example, the source host sends three ICMP echo request packets to the first hop (192.168.1.1) with the
TTL value of 1. When the router 192.168.1.1 receives the echo request packets, it decrements the TTL value
to 0. The router sends an ICMP Time Exceeded message back to the source. This process continues until the
source hosts sends the last three ICMP echo request packets with TTL values of 8 (hop nhumber 8 in the out-
put below), which is the final destination. After the ICMP echo request packets arrive at the final destination,
the router responds to the source with ICMP echo replies.

For hops 2 and 3, these IP addresses are private addresses. These routers are the typical setup for point-of-
presence (POP) of ISP. The POP devices connect users to an ISP network.

A web-based whois tool is found at http://whois.domaintools.com/. It is used to determine the domains trav-
eled from the source to destination.

a. Atthe command-line prompt, trace the route to www.cisco.com. Save the tracert output in a text file.
Alternatively, you can redirect the output to a text file by using > or >>.

C:\Users\Userl> tracert www.cisco.com
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or

C:\Users\Userl> tracert www.cisco.com > tracert-cisco.txt

Tracing route to el44.dscb.akamaiedge.net [23.67.208.170]

over a maximum of 30 hops:

w N

7
8

[23.67.208.170]

Trace complete.

b. The web-based tool at http://whois.domaintools.com/ can be used to determine the owners of both the
resulting IP address and domain names shown in the tracert tools output. Now perform a tracert to one of
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38
33
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192.168.1.1

10.39.0.1

172.21.0.118

70.169.73.196

70.169.75.157

68.1.2.109

Equinix-DFW2.netarch.akamai.com [206.223.118.102]

a23-67-208-170.deploy.akamaitechnologies.com

RIR web sites from Part 1 and save the results.

Africa:

Australia:

Europe:

South America:

North America:

www.afrinic.net

www.aphnic.net

www.ripe.net

www.lacnic.net

www.arin.net

List the domains below from your tracert results using the web-based whois tool.

c. Compare the lists of domains crossed to reach the final destinations.

Reflection

What can affect tracert results?
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1.1.4.6 Lab — Configuring Basic Router Settings with 10S CLI

Topology

Addressing Table

Device Interface IP Address Subnet Mask Default Gateway
R1 GO0/0 192.168.0.1 255.255.255.0 N/A
GO0/1 192.168.1.1 255.255.255.0 N/A
PC-A NIC 192.168.1.3 255.255.255.0 192.168.1.1
PC-B NIC 192.168.0.3 255.255.255.0 192.168.0.1
Objectives

Part 1: Set Up the Topology and Initialize Devices

e (Cable equipment to match the network topology.

e |nitialize and restart the router and switch.
Part 2: Configure Devices and Verify Connectivity

e Assign static IPv4 information to the PC interfaces.
e Configure basic router settings.
o Verify network connectivity.

e Configure the router for SSH.
Part 3: Display Router Information

e Retrieve hardware and software information from the router.
e Interpret the output from the startup configuration.
e Interpret the output from the routing table.

o Verify the status of the interfaces.

Part 4: Configure IPv6 and Verify Connectivity

Background / Scenario

This is a comprehensive lab to review previously covered 10S router commands. In Parts 1 and 2, you will
cable the equipment and complete basic configurations and IPv4 interface settings on the router.
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In Part 3, you will use SSH to connect to the router remotely and utilize IOS commands to retrieve information
from the device to answer questions about the router. In Part 4, you will configure IPv6 on the router so that
PC-B can acquire an IP address and then verify connectivity.

For review purposes, this lab provides the commands necessary for specific router configurations.

Note: The routers used with CCNA hands-on labs are Cisco 1941 Integrated Services Routers (ISRs) with
Cisco 10S Release 15.2(4)M3 (universalk9 image). The switches used are Cisco Catalyst 2960 with Cisco
IOS Release 15.0(2) (lanbasek9 image). Other routers, switches, and Cisco 10S versions can be used. De-
pending on the model and Cisco 10S version, the commands available and output produced might vary from
what is shown in the labs. Refer to the Router Interface Summary Table at the end of this lab for the correct
interface identifiers.

Note: Make sure that the router and switch have been erased and have no startup configurations. Refer to
Appendix A for the procedures to initialize and reload devices.

Required Resources

e 1 Router (Cisco 1941 with Cisco |IOS Release 15.2(4)M3 universal image or comparable)
o 1 Switch (Cisco 2960 with Cisco IOS Release 15.0(2) lanbasek9 image or comparable)

e 2 PCs (Windows 7, Vista, or XP with terminal emulation program, such as Tera Term)

e Console cables to configure the Cisco 10S devices via the console ports

e Ethernet cables as shown in the topology

Note: The Gigabit Ethernet interfaces on Cisco 1941 ISRs are autosensing and an Ethernet straight-through
cable can be used between the router and PC-B. If using another model Cisco router, it may be necessary to
use an Ethernet crossover cable.

Part 1: Set Up the Topology and Initialize Devices

Step 1: Cable the network as shown in the topology.
a. Attach the devices as shown in the topology diagram, and cable as necessary.

b. Power on all the devices in the topology.

Step 2: Initialize and reload the router and switch.

Note: Appendix A details the steps to initialize and reload the devices.

Part 2: Configure Devices and Verify Connectivity

Step 1: Configure the PC interfaces.
a. Configure the IP address, subnet mask, and default gateway settings on PC-A.

b. Configure the IP address, subnet mask, and default gateway settings on PC-B.

Step 2: Configure the router.

a. Console into the router and enable privileged EXEC mode.

Router> enable

Router#
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Enter into global configuration mode.

Router# config terminal

Router (config) #
Assign a device name to the router.
Router (config) # hostname R1

Disable DNS lookup to prevent the router from attempting to translate incorrectly entered commands as
though they were hostnames.

Rl (config)# no ip domain-lookup
Require that a minimum of 10 characters be used for all passwords.
Rl (config) # security passwords min-length 10

Besides setting a minimum length, list other ways to strengthen passwords.

Assign cisco12345 as the privileged EXEC encrypted password.
Rl (config) # enable secret ciscol2345

Assign ciscoconpass as the console password, establish a timeout, enable login, and add the logging
synchronous command. The logging synchronous command synchronizes debug and Cisco 10S soft-
ware output and prevents these messages from interrupting your keyboard input.

Rl (config)# line con O

Rl (config-line) # password ciscoconpass
Rl (config-line) # exec-timeout 5 0

Rl (config-line)# login

Rl (config-line)# logging synchronous
Rl (config-line) # exit

Rl (config) #

For the exec-timeout command, what do the 5 and 0 represent?

Assign ciscovtypass as the vty password, establish a timeout, enable login, and add the logging syn-
chronous command.

Rl (config)# line vty 0 4

Rl (config-line) # password ciscovtypass
Rl (config-line)# exec-timeout 5 0

Rl (config-line)# login

Rl (config-line) # logging synchronous
Rl (config-line) # exit

Rl (config) #
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i. Encrypt the clear text passwords.
Rl (config) # service password-encryption
j.  Create a banner that warns anyone accessing the device that unauthorized access is prohibited.
Rl (config) # banner motd #Unauthorized access prohibited!#
k. Configure an IP address and interface description. Activate both interfaces on the router.
Rl (config) # int g0/0
Rl (config-if) # description Connection to PC-B
Rl (config-if)# ip address 192.168.0.1 255.255.255.0
Rl (config-if) # no shutdown
Rl (config-if)# int g0/1
Rl (config-if) # description Connection to S1
Rl (config-if)# ip address 192.168.1.1 255.255.255.0
Rl (config-if) # no shutdown
Rl (config-if)# exit
Rl (config) # exit
R1#
I.  Set the clock on the router; for example:
R1# clock set 17:00:00 18 Feb 2013

m. Save the running configuration to the startup configuration file.

R1# copy running-config startup-config
Destination filename [startup-config]?
Building configuration...

[OK]

R1#

What would be the result of reloading the router prior to completing the copy running-config startup-
config command?

Step 3:  Verify network connectivity.
a. Ping PC-B from a command prompt on PC-A.
Note: It may be necessary to disable the PCs firewall.

Were the pings successful?

After completing this series of commands, what type of remote access could be used to access R1?
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b. Remotely access R1 from PC-A using the Tera Term Telnet client.

Open Tera Term and enter the G0/1 interface IP address of R1 in the Host: field of the Tera Term: New
Connection window. Ensure that the Telnet radio button is selected and then click OK to connect to the

router.
Tera Term: Mew connection @
@ TCPHP Host: 192.168.1.1 -
- 23
Service: @ Telnet Ul Eert s
o 55H SSHversion: SSH?
) Other
Protocol: [UNSPEC ~
Serial
| OK ‘ ‘ Cancel | | Help ‘

Was remote access successful?

Why is the Telnet protocol considered to be a security risk?

Step 4: Configure the router for SSH access.

a. Enable SSH connections and create a user in the local database of the router.

R1# configure terminal

Rl (config)# ip domain-name CCNA-lab.com

Rl (config) # username admin privilege 15 secret adminpassl
Rl (config)# line vty 0 4

Rl (config-line)# transport input ssh

Rl (config-line) # login local

Rl (config-line) # exit

Rl (config) # crypto key generate rsa modulus 1024

Rl (config)# exit

b. Remotely access R1 from PC-A using the Tera Term SSH client.

Open Tera Term and enter the G0/1 interface IP address of R1 in the Host: field of the Tera Term: New
Connection window. Ensure that the SSH radio button is selected and then click OK to connect to the
router.
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-
Tera Term: Mew connection @

@ TCFIP Host: 192.168.1.1 -
History
- 22
Service: © Telnet TCP port#:

55H version: |SSH2 =

Protocol: [UNSPEC -~

Serial

| OK ‘ ‘ Cancel | | Help

Was remote access successful?

Part 3: Display Router Information

In Part 3, you will use show commands from an SSH session to retrieve information from the router.

Step 1: Establish an SSH session to R1.

Using Tera Term on PC-B, open an SSH session to R1 at IP address 192.168.0.1 and log in as admin with
the password adminpass1.

Step 2: Retrieve important hardware and software information.

a. Use the show version command to answer questions about the router.
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What is the name of the 10S image that the router is running?

How much non-volatile random-access memory (NVRAM) does the router have?

How much Flash memory does the router have?

b. The show commands often provide multiple screens of outputs. Filtering the output allows a user to
display certain sections of the output. To enable the filtering command, enter a pipe (|) character after a
show command, followed by a filtering parameter and a filtering expression. You can match the output to
the filtering statement by using the include keyword to display all lines from the output that contain the
filtering expression. Filter the show version command, using show version | include register to answer
the following question.

What is the boot process for the router on the next reload?

Step 3: Display the startup configuration.

Use the show startup-config command on the router to answer the following questions.
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How are passwords presented in the output?

Use the show startup-config | begin vty command.

What is the result of using this command?

Step 4: Display the routing table on the router.

Use the show ip route command on the router to answer the following questions.
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What code is used in the routing table to indicate a directly connected network?

How many route entries are coded with a C code in the routing table?

Step 5: Display a summary list of the interfaces on the router.

Use the show ip interface brief command on the router to answer the following question.

What command changed the status of the Gigabit Ethernet ports from administratively down to up?

Part 4: Configure IPv6 and Verify Connectivity

Step 1: Assign IPv6 addresses to R1 G0/0 and enable IPv6 routing.

Note: Assigning an IPv6 address in addition to an IPv4 address on an interface is known as dual stacking,
because both the IPv4 and IPv6 protocol stacks are active. By enabling IPv6 unicast routing on R1, PC-B
receives the R1 G0/0 IPv6 network prefix and can autoconfigure its IPv6 address and its default gateway.

a. Assign an IPv6 global unicast address to interface G0/0, assign the link-local address in addition to the
unicast address on the interface, and enable IPv6 routing.

R1# configure terminal

Rl (config)# interface g0/0

Rl (config-if)# ipvé address 2001:db8:acad:a::1/64
Rl (config-if) # ipv6é address fe80::1 link-local

Rl (config-if) # no shutdown

Rl (config-if) # exit

Rl (config) # ipv6 unicast-routing

Rl (config)# exit
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b. Use the show ipv6 int brief command to verify IPv6 settings on R1.

If no IPv6 address is assigned to GO/1, why is it listed as [up/up]?

c. Issue the ipconfig command on PC-B to examine the IPv6 configuration.

What is the IPv6 address assigned to PC-B?

What is the default gateway assigned to PC-B?
Issue a ping from PC-B to the R1 default gateway link local address. Was it successful?

Issue a ping from PC-B to the R1 IPv6 unicast address 2001:db8:acad:a::1. Was it successful?

Reflection

1. In researching a network connectivity issue, a technician suspects that an interface was not enabled. What
show command could the technician use to troubleshoot this issue?

2. Inresearching a network connectivity issue, a technician suspects that an interface was assigned an incorrect
subnet mask. What show command could the technician use to troubleshoot this issue?

3. After configuring IPv6 on the R1 GO/0 PC-B LAN, if you were to ping from PC-A to the PC-B IPv6 address,
would the ping succeed? Why or why not?
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Router Interface Summary Table

Router Interface Summary

Router Model

Ethernet Interface #1

Ethernet Interface #2

Serial Interface #1

Serial Interface #2

1800

Fast Ethernet 0/0
(FO/0)

Fast Ethernet 0/1
(FO/M)

Serial 0/0/0 (S0/0/0)

Serial 0/0/1 (S0/0/1)

(GO/0)

(GO/1)

1900 Gigabit Ethernet 0/0 Gigabit Ethernet 0/1 Serial 0/0/0 (S0/0/0) | Serial 0/0/1 (S0/0/1)
(G0/0) (G0/1)

2801 Fast Ethernet 0/0 Fast Ethernet 0/1 Serial 0/1/0 (S0/1/0) | Serial 0/1/1 (S0/1/1)
(F0/0) (FO/1)

2811 Fast Ethernet 0/0 Fast Ethernet 0/1 Serial 0/0/0 (S0/0/0) | Serial 0/0/1 (S0/0/1)
(FO/0) (FO/1)

2900 Gigabit Ethernet 0/0 Gigabit Ethernet 0/1 Serial 0/0/0 (S0/0/0) | Serial 0/0/1 (S0/0/1)

Note: To find out how the router is configured, look at the interfaces to identify the type of router and how many

interfaces the router has. There is no way to effectively list all the combinations of configurations for each router
class. This table includes identifiers for the possible combinations of Ethernet and Serial interfaces in the device.
The table does not include any other type of interface, even though a specific router may contain one. An example
of this might be an ISDN BRI interface. The string in parenthesis is the legal abbreviation that can be used in
Cisco I0S commands to represent the interface.

Appendix A: Initializing and Reloading a Router and Switch

Step 1:

Initialize and reload the router.

a. Console into the router and enable privileged EXEC mode.

Router> enable

Router#

b. Type the erase startup-config command to remove the startup configuration from NVRAM.

Router# erase startup-config

Erasing the nvram filesystem will remove all configuration files! Continue?

[OK]

Erase of nvram:

Router#

complete

[confirm]

c. Issue the reload command to remove an old configuration from memory. When prompted to Proceed
with reload, press Enter to confirm the reload. (Pressing any other key aborts the reload.)

Router# reload

Proceed with reload?

*Nov 29 18:28:09.923:

Reload Command.

[confirm]

%$SYS-5-RELOAD: Reload requested by console.

Reload Reason:

Note: You may be prompted to save the running configuration prior to reloading the router. Type no and
press Enter.

System configuration has been modified.

Save?

[yes/no]: no
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Step 2:

After the router reloads, you are prompted to enter the initial configuration dialog. Enter no and press
Enter.

Would you like to enter the initial configuration dialog? [yes/no]l: no
You are prompted to terminate autoinstall. Type yes and then press Enter.

Would you like to terminate autoinstall? [yes]: yes

Initialize and reload the switch.

Console into the switch and enter privileged EXEC mode.

Switch> enable

Switch#
Use the show flash command to determine if any VLANs have been created on the switch.

Switch# show flash

Directory of flash:/

2  -rwx 1919 Mar 1 1993 00:06:33 +00:00 private-config.text
3 -rwx 1632 Mar 1 1993 00:06:33 +00:00 config.text
4  -rwx 13336 Mar 1 1993 00:06:33 +00:00 multiple-fs

5 -rwx 11607161 Mar 1 1993 02:37:06 +00:00 c¢2960-lanbasek9-mz.150-2.SE.bin
6 -rwx 616 Mar 1 1993 00:07:13 +00:00 wvlan.dat

32514048 bytes total (20886528 bytes free)

Switch#
If the vlan.dat file was found in flash, then delete this file.

Switch# delete vlan.dat
Delete filename [vlan.dat]?

You are prompted to verify the filename. At this point, you can change the filename or just press Enter if
you have entered the name correctly.

You are prompted to confirm deleting this file. Press Enter to confirm deletion. (Pressing any other key
aborts the deletion.)

Delete flash:/vlan.dat? [confirm]

Switch#

Use the erase startup-config command to erase the startup configuration file from NVRAM. You are
prompted to confirm removing the configuration file. Press Enter to confirm to erase this file. (Pressing
any other key aborts the operation.)

Switch# erase startup-config

Erasing the nvram filesystem will remove all configuration files! Continue? [confirm]
[OK]

Erase of nvram: complete

Switch#



18

Chapter 1 — Routing Concepts

Reload the switch to remove any old configuration information from memory. You are prompted to confirm
reloading the switch. Press Enter to proceed with the reload. (Pressing any other key aborts the reload.)

Switch# reload

Proceed with reload? [confirm]

Note: You may be prompted to save the running configuration prior to reloading the switch. Type no and
press Enter.

System configuration has been modified. Save? [yes/no]: no

After the switch reloads, you should be prompted to enter the initial configuration dialog. Type no and
press Enter.

Would you like to enter the initial configuration dialog? [yes/no]: no

Switch>
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1.1.4.7 Lab — Configuring Basic Router Settings with CCP

Topology

Addressing Table

Device Interface IP Address Subnet Mask Default Gateway
R1 G0/0 192.168.0.1 255.255.255.0 N/A
G0N 192.168.1.1 255.255.255.0 N/A
S1 VLAN 1 N/A N/A N/A
PC-A NIC 192.168.1.3 255.255.255.0 192.168.1.1
PC-B NIC 192.168.0.3 255.255.255.0 192.168.0.1
Objectives

Part 1: Set Up the Topology and Initialize Devices
Part 2: Configure Devices and Verify Connectivity
Part 3: Configure Router to Allow CCP Access
Part 4: (Optional) Install and Set Up CCP on PC-A
Part 5: Configure R1 Settings Using CCP

Part 6: Use CCP Utilities

Background / Scenario

Cisco Configuration Professional (CCP) is a PC-based application that provides GUI-based device manage-
ment for Integrated Services Routers (ISRs). It simplifies the configuration of routing, firewall, VPN, WAN,
LAN, and other settings through menus and easy-to-use wizards.

In this lab, you will configure the router settings using the configuration from the previous lab in this chapter.
Layer 3 connectivity must be established between the PC running CCP (PC-A) and R1 before CCP can es-
tablish a connection. In addition, HTTP access and authentication must be configured on R1.

You will download and install CCP on the PC and then use it to monitor R1’s interface status, configure an
interface, set the date and time, add a user to the local database, and edit vty settings. You will also use some
of the utilities included in CCP.

Note: Router configurations performed using CCP generate IOS CLI commands. CCP can be very useful for
configuring more complex router features because it does not require specific knowledge of the Cisco 10S
command syntax.
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Note: The routers used with CCNA hands-on labs are Cisco 1941 Integrated Services Routers (ISRs) with
Cisco I0S Release 15.2(4)M3 (universalk9 image). The switches used are Cisco Catalyst 2960s with Cisco
IOS Release 15.0(2) (lanbasek9 image). Other routers, switches, and Cisco I0S versions can be used. De-
pending on the model and Cisco IOS version, the commands available and output produced might vary from
what is shown in the labs. Refer to the Router Interface Summary Table at the end of this lab for the correct
interface identifiers.

Note: Make sure that the router and switch have been erased and have no startup configurations. If you are
unsure, contact your instructor.

Required Resources

e 1 Router (Cisco 1941 with Cisco |IOS Release 15.2(4)M3 universal image or comparable)
o 1 Switch (Cisco 2960 with Cisco IOS Release 15.0(2) lanbasek9 image or comparable)

e 2 PCs (Windows 7, Vista, or XP with terminal emulation program, such as Tera Term)

e Console cables to configure the Cisco IOS devices via the console ports

o Ethernet cables as shown in the topology
Note: PC system requirements for CCP version 2.6 are:

e 2 GHz processor or faster

e 1 GB DRAM minimum; 2 GB recommended

e 400 MB of available hard disk space

e Internet Explorer 6.0 or above

e Screen resolution of 1024x768 or higher

e Java Runtime Environment (JRE) version 1.6.0_11 or later.

e Adobe Flash Player version 10.0 or later, with Debug set to No

Note: The Gigabit Ethernet interfaces on Cisco 1941 ISRs are autosensing and an Ethernet straight-through
cable may be used between the router and PC-B. If using another model Cisco router, it may be necessary to
use an Ethernet crossover cable.

Part 1: Set Up the Topology and Initialize Devices

Step 1: Cable the network as shown in the topology.
a. Attach the devices shown in the topology diagram, and cable as necessary.

b. Power on all the devices in the topology.

Step 2: Initialize and reload the router and switch.

Part 2: Configure Devices and Verify Connectivity

In Part 2, you will configure basic settings, such as the interface IP addresses (G0/1 only), secure device ac-
cess, and passwords. Refer to the Topology and Addressing Table for device names and address information.
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Step 1: Configure the PC interfaces.
a. Configure the IP address, subnet mask, and default gateway settings on PC-A.

b. Configure the IP address, subnet mask, and default gateway settings on PC-B.

Step 2: Configure the router.
Note: Do NOT configure interface G0/0 at this time. You will configure this interface using CCP later in the lab.
a. Console into the router and enable privileged EXEC mode.
b. Enter into global configuration mode.
c. Disable DNS lookup.
d. Assign a device name to the router.
e. Require that a minimum of 10 characters be used for all passwords.
f.  Assign cisco12345 as the privileged EXEC encrypted password.
g. Assign ciscoconpass as the console password and enable login.
h. Assign ciscovtypass as the vty password and enable login,
i. Configure logging synchronous on the console and vty lines.
j- Encrypt the clear text passwords.
k. Create a banner that warns anyone accessing the device that unauthorized access is prohibited.
I.  Configure the IP addresses, an interface description, and activate G0/1 interface on the router.

m. Save the running configuration to the startup configuration file.

Step 3: Verify network connectivity.

Verify that you can ping R1 G0/1 from PC-A.

Part 3: Configure the Router to Allow CCP Access

In Part 3, you will set up the router to allow CCP access by enabling HTTP and HTTPS server services. You
will also enable HTTP authentication to use the local database.

Step 1: Enable HTTP and HTTPS server services on the router.
Rl (config) # ip http server
Rl (config) # ip http secure-server
Step 2: Enable HTTP authentication to use the local database on the router.

Rl (config)# ip http authentication local
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Step 3: Configure the router for CCP access.

Assign a user in the router local database for accessing CCP using username admin and password admin-
pass1.

Rl (config) # username admin privilege 15 secret adminpassl

Part 4: (Optional) Install and Set Up CCP on PC-A

Step 1:

Install CCP.

Note: This step can be skipped if CCP is already installed on PC-A.

a.

Step 2:

Download CCP 2.6 from Cisco’s website:

http://software.cisco.com/download/release.htm|?mdfid=281795035&softwareid=282159854&release=2.6
&rellifecycle=&relind=AVAILABLE&reltype=all

Choose the cisco-config-pro-k9-pkg-2_6-en.zip file.

Note: Verify that you select the correct CCP file and not CCP Express. If there is a more current release
of CCP, you may choose to download it; however, this lab is based on CCP 2.6.

Agree to the terms and conditions, and download and save the file to the desired location.
Open the zip file and run the CCP executable.

Follow the on-screen instructions to install CCP 2.6 on your PC.

Change settings to run as the administrator.

CCP may fail to launch correctly if it is not run as an administrator. You can change the launch settings so that
it automatically runs in administrator mode.

a.

Right-click the CCP desktop icon (or click the Start button) and then right-click Cisco Configuration
Professional. In the drop-down list, select Properties.

In the Properties dialog box, select the Compatibility tab. In the Privilege Level section, click the Run
this program as an administrator checkbox, and then click OK.



1.1.4.7 Lab — Configuring Basic Router Settings with CCP 23

4 Cisco Configuration Professional Properties 23
Security I Details I Previous Versions |
General I Shorteut | Compatibility

if you have problems with this program and it worked comectly on
an earlier version of Windows, select the compatibility mode that
matches that earlier version.
Help me choose the settings

Compatibility mode

[] Run this program in compatibility mode for:

Windows XP (Service Pack 3)

Settings
[ Run in 256 colors
[T] Run in 540 x 480 screen resolution
[] Disable visual themes
[ Digable desktop compostion
[ Disable display scaling on high DP| settings

Privilege Level
‘ Run this program as an administrator

[ '&'Change settings for all users l

oK || Cancel Apply

Step 3: Create or manage communities.

a. On PC-A, start CCP. (Double-click the CCP desktop icon or click Start > Cisco Configuration Profes-
sional.)

b. If you receive a security warning message prompting to allow the CiscoCP.exe program to make changes
to the computer, click Yes.

@' User Account Control @

O Do you want to allow the following program from an
’ unknown publisher to make changes to this computer?

Programn name:  CiscoCP.exe

Publisher Unknown
File origin: Hard drive on this computer
'::'E'::' Show details Yes ] [ Mo

Change when these notifications appear

c. When CCP starts, the Select / Mange Community dialog box displays. Enter the IP address for R1 G0/1,
and the username admin and password adminpass1 that you added to the local database during the
router configuration in Part 2. Click OK.
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Enter information for up to 5 devices for the selected community

1P Address/Hostname Username Password

192.1658.1.1 admin |*********

|:| Discover all devices

d. Inthe Community Information window, click Discover.

Application  Help

Q) Home || {0} contigure || [ momtor | | o v =2 €  cisco Configuration Professional *!l!1!l1:

cisco
. "l
Q«It Community Member: Home > Dashboard e
“ 7
{No devices discovered) | v ‘
[l cisco© i ional News : due to connection failure with www.cisco.com /

{ |_j Community View > N

I Community Information

14 ’

; Selectsd Community: New Community .Select a device from the tsble below. Use the buttons at the bottom to continus.

| FFilkar | 1 rovs retriaved |

IP address / Hostname Router < ion Type Discovery Status

7 Flash File Management -
-l

;,/;’Cﬂnfiguratiun Editor [ Manage Devices J[ Delete ] q Dig:nver-D Discovery Details | | Cancel Discovery | | RouterStatus |
Save Configuration to PC E| =

If you have configured the router correctly, the Discovery Status changes from Not discovered to Dis-
covered, and R1 appears in the Router Hostname column.

Note: If there is a problem with your configuration, you will see a “Discovery failed” status. Click Discov-
ery Details to determine why the discovery process failed and then troubleshoot the problem.
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Part 5: Configure R1 Settings Using CCP

In Part 5, you will use CCP to display information about R1, configure interface GO0/0, set the date and time
add a user to the local database, and change your vty settings.

Step 1: View the status of the interfaces on R1.

a. On the CCP toolbar, click Monitor.

Monitor

)

:@ pore | 85 conpoes

In the left navigation pane, click Router > Overview to display the Monitor Overview screen in the right
content pane.

W http://127.0.0 1:8600/ Counterpoint/CPMain.html?rand=23745 - Windows Internet Explorer
r Application Help

==

3
|
| - -] = = - - - |
| Q) Home || {3 configure @ monitor | | fe U €  cisco Configuration Professional ' hhel,
! — Cisco
Select Community Member:
) “ Monitor > Router > Overview
mre
G Router
Resource Status
[ Interface Status CPU Usager—————————————————— Memory Usage: Flash Usage:
| Enviranment I:
1] Logging ’
» (I3 Traffic Status LL  Interface Status
[ Qos status Total Interface(s) Up: 1 Total Interface(s) Down:
Interface 1P Status Bandwidth Usage Description
P i Security Enginel no ip 2 0%
GigahitEthernet0m noip address 0% =
I =1 ] v
% Firewall Status
No. of Attempts Denied: 0 No. of QoS Enabled Interfaces:
Firewall Log: Mot Configured
T = #5 VPN Status
o Flash File Management +|  No.of Open IPSec Tunnels: 0 No. of DMVPN Clients: i
%Conflguratlon Editor No. of Open IKE SAs: 1] Mo. of Active VPN Clients: MY
/" 8ave Configuration to PC =
*Write to Startup Configuration
Tt Total Log Entries: 36 High Severity: [E
+*Reload Davice =l ‘ = \Warnina: ] : y Lo

c. Use the up and down arrows to the right of the interface list to scroll through the list of interfaces for the
router.

. Interface Status

Total Interface(s) Up: 1 Total Interface(s) Down: 4
Interface | P | Status  Bandwidth Usage Description
GigakitEthernetonm noip address & Down 0% -
GigabitEthernetOn 192.168.1.1 & Up 0% .
ol
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Step 2:

a.

b.

Use the Ethernet LAN wizard to configure interface G0/0.

On the CCP toolbar, click Configure.

l_@ Hnmeq—-’%{ﬂ Cnnﬁgu_r::‘? Monitor ]

In the left navigation pane, click Interface Management > Interface and Connections to display the
Interfaces and Connections screen in the right content pane.

¥ = Interface Management

€I Interface and Connection

[ Energywise
» (] Router
¥ [ Security k

utilities
#/*Flash File Management
" Configuration Editor
2/ 5ave Configuration to PC
4/ Wirita to Startup Canfiguration

' Telnet
/#Reload Davica

Click Create New Connection to start the Ethernet LAN wizard.

=

"“-';g.i_ Interfaces and Connections

Create Connection | Edit Interface/Connection

Create New Connection
Select a connection and click Create Mew Connection
(¥ Ethernet LAN
{” Ethernet {PPPoE or Unencapsulated Routing)
™ Other (Unsupported by Cisco CF)
Information

Configura Etharmat LAN intarface for straight routing
and 802,14 trunking

Create New Connection

How do!: How Do | Configure an Unsupported WAN Interface?

Use Case Scenario

gmj

When you are prompted to enable AAA on the router, click No.

Click Next to be guided through the Layer 3 Ethernet interface creation process.

Keep the Configure this interface for straight routing radio button selected and click Next.

Enter 192.168.0.1 in the IP address field and 255.255.255.0 in the Subnet mask field and click Next.

Keep the No radio button selected on the DHCP server screen and click Next.

Review the summary screen and click Finish.

Click the Save running config to device’s startup config check box, and then click Deliver. This adds
the commands shown in the preview window to the running configuration, and then saves the running
configuration to the startup configuration on the router.

The Commands Delivery Status window displays. Click OK to close this window. You will be routed back
to the Interfaces and Connections screen; GO/0 should have turned green and displayed as Up in the

Status column.
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Interface

IP

Type

[ sint [ status | Description

GigahitEthern

Step 3: Set the date and time on the router.

Embedded-Senice-Engi no IP address

0i0 18

GigahitEthernet0i 192.168.11

Sertial0ro no IP addres
Sertial0nnm no IP addres

GigabitEthernet
Serial
Serial

s
s

Embedded-Serice-Engine 0
GigahitEthernet

o R R e

& Dow

€ up
& Dow
& Dow

Connection ta 51 FOrS

a. Inthe left navigation pane, select Router > Time > Date and Time to display the Additional Tasks > Date/
Time screen in the right content pane. Click Change Settings....

?f hﬂpcﬂ]Z%.D.l:SﬁWfCountelpointhPMain.html?lamtB?‘lS - Windows Internet Explorer

Application  Help

NEESE==] ==

Select Community Member:

) - 2
aln d
v ¥4 [ E)
A,
Lod Configure > Router > Time > Date and Time

¥ 5 Interface Manzgement

[} interface and Connections

) Energywise
Y5 Router ™
] Router Options
¢ Date and Time

| NTP and SNTP
[ Router Access

b. In the Date and Time Properties window, edit the Date, Time, and Time Zone. Click Apply.

Datei/Time

Date and Time Properties

Device's Date | Time :

' Edit Date and Time
Date

February -

10 11 12 12
17 18 12 20
24 25 26 27

Time Zone

(GMT-07:00) Arizona

Device Time Source :

Change Seftings... )
—————

10:18:39 Arizona Fri Feb 15 2013

¢~ Synchronize with my local PC clock

2012 -

7 8
14 B
21 22
28
Close

Hardware Calendar

Time

Help

Cisco Configuration Professional

PH Additional Tasks

(24 - hour clock)

hr

mim

S5

o e a0

Apply |

c. Inthe Router’s clock configured window, click OK. In the Date and Time Properties window, click Close.

Nme
cIsco

elelE=s

@

-




28 Chapter 1 — Routing Concepts

Step 4: Add a new user account to the local database.

a. In the left navigation pane, select Router > Router Access > User Accounts/View to display the Addi-
tional Tasks > User Accounts/View screen in the content pane on the right. Click the Add... button.

Configure > Router > Router Access > User Accounts/View @

«
192.168.1.1 | *

ys) fil Additional Tasks
¥ 5 Interface Managemant = User Accounis/View cail Delete

|} Interface and Connections

Username Passward Privilege Lewe| View MNarme

) Energywise
¥ E3Router
[) Router Options
¥ £y Time

[} pate and Time

=Mone=

admin

d NTP and SNTP
T

B

CC[Dser Accounts/Vieys

Ovrr

m

b. Enter ccpadmin in the Username: field. Enter ciscoccppass in the New Password: and Confirm New
Password: fields. Select 15 in the Privilege Level: drop-down list. Click OK to add this user to the local

database.

x

Enter the username and password

sername: ccpadmin
Password
Passwaord =Mane=
New F}asswnrd I****t*******

Confirm Mew Password:

I****t*******

¥ Encrypt password using MDS hash algorithm

Privilege Level: 15 =

[T As=zociate a View with the user

View Mame : |CCF'__i.-jministrat-:unjr-:u-:ntj: j View Details... |

OK Cancel Help

c. Inthe Deliver Configuration to Device window, click the Save running config to device’s startup config
check box, and then click Deliver.



1.1.4.7 Lab — Configuring Basic Router Settings with CCP 29

d. Review the information in the Commands Delivery Status window, and click OK. The new user account
should now appear in the content pane on the right.

i'"g'l Additional Tasks

User Accounts/View Add... | Edit... I Delete |
Username Fassword Frivilege Level Wiew Mame

admin =Mone=

ccpadmin A 15 =Mone=

Step 5: Edit vty line settings.

a. Inthe left navigation pane, select Router Access > VTY to display the Additional Tasks > VTYs screen in
the content pane on the right. Click Edit....
| SEIbE” « Configure > Router > Router Access > VTY @"
¥ E5 Interface Management =
) Interface and Connections e M
[ Energywise Iterm MName ltern Yalue
¥ E5 Router
[ Router Options Input Protocols Allowed ssh
= Cutput Protocols Allowed Mane
v &5 Time EXEC timeout 5
|| pate and Time Inbound Access-class None
[ WTe and SnTR Outhound Access-class MNang
¥ E5 Router Access
[ User Accounts/View F
I
| | Management Access
b.

In the Edit VTY Lines window, change the Time out: field to 15 minutes. Click the Input Protocol > Telnet
check box. Review the other options available. Also select the SSH checkbox. Then click OK.

ﬂ
Line Range
Lines: Iu— - |4_
Time out: |‘15 minutes
Input Protocol Cutput Protocal
M Telnet M sSsH [Tall [MTeinet TssH Mal
Access Rule
Inbound: I ,\_l
Outbound: I \‘l
0K | Cancel Help |
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c. Review the commands that will be delivered to the running configuration on the Deliver Configuration to
Device screen and click Deliver. In the Commands Delivery Status window, click OK. The content pane
on the right should reflect the changes to the EXEC timeout value.

Configure > Router > Router Access > VTY @

ﬁl Additional Tasks
VTYs Edit... |

lterm Mame lterm Walue
Input Protocols Allowed sshtelnet
Qutput Protocols Allowed MHone
EXEC timeout 15
Inkound Access-class Mane
Cutbound Access-class one

Part 6: Use CCP Utilities

In Part 6, you will use the Utilities pane to save the router’s running configuration to the startup configuration.
The Ping utility will be used to test network connectivity, and the View utility will be used to show the router’s
running configuration. Finally, you will close CCP.

Step 1: Save the router’s running configuration to the startup configuration.

a. At the bottom of the left navigation pane, locate the Utilities pane. Click Write to Startup Configuration.

Utilities
&Flash Fila Management
ﬁCaniguration Editor
aﬂfgﬁave Configuration to PC
F)_f')/-g\.l\h’ritﬁt to Startup Configuration
ar)r?’Telnet
fReload Devica
‘{/W’Ping and Traceroute
!’E\ﬁew
%Running Configuration
E‘J/fgIDS Show Commands
&l%‘DeFault Rules

b. The content pane displays a confirmation screen. Click Confirm. An Information window displays, letting
you know that the configuration was saved successfully. Click OK.

Step 2: Use the Ping utility to test connectivity to PC-B.

a. Inthe Utilities pane, click Ping and Traceroute to display the Ping and Traceroute screen in the content
pane. Enter 192.168.0.3 in the Destination*: field and then click Ping. Use the scrollbar to the right of the
results box to view the results of your ping.
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Utilities > Ping and Traceroute

Destination®:  192,188.0.3 Advanced (¥)

(IP Address or Hostname)

Ping H Traceroute I

Sending 5, 100-byte ICMP Echos to 192.168.0.3, timecut is 2 seconds:

Success rate is 100 percent (5/5), round-trip min/avg/max = 1/1/4 ms

Clear

* - indicates mandatory field

Step 3:  Use the View utility to show the running configuration for the router.

a. In the Utilities pane, click View > 10S Show Commands to display the IOS Show Commands screen in
the content pane.

Utilities
%Flaah File Management
E'}'CnnFiguratinn Editor
%53'.‘& Configuration to PC
gf’k“'}rite to Startup Configuration
%Telnet
&'Relnad Device
l%‘l}ing and Traceroute
TZView
&'Running Configuration
F{F&'IDE Show Commands
%Default Rules

b. Select show run from the drop-down list and click Show. The router’s running configuration is displayed
in the content pane.
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Utilities > View > I0S Show Commands @

Enter a show command or select from the list and click the 'Show' button

show run ILJ Show

Building configuration...

Current configuration : 2576 bytes
1

! Last configuration change at 18:43:38 UTC Fri Feb 15 2013 by admin
! NWVRAM config last updated at 18:57:31 UTC Fri Feb 13 2013 by admin
! NWRAM config last updated at 18:57:31 UTC Fri Feb 15 2013 by admin
wersion 15.2

service timestamps debug datetime msec

service timestamps log datetime msec

service password-encryption

!

hostname R1

!

boot-start-marker

boot-end-marker

!

!

no loegging buffered

enable secret 5 $15rWej$SfolkH.43YVdrK2ZUALITk.

!

no aa=s newmodel

!

memory-size iomem 10

!

no ipvs caf

ip auth-proxy max-login-attempts 5

ip admission max-login-attempts 3

[+]

Step 4: Close CCP.

Close the CCP window. When a Windows Internet Explorer confirmation window displays, click Leave this
page.

Windows Internet Explorer

=

) Are you sure you want to leave this page?

Message from webpage:

Warning: All unsaved data will be lost.
MNote: To provide user feedback, press Cancel then
select Help > Feedback in the menu.

2 Leave this page

= Stay on this page

Reflection

1. What transport protocol does CCP use to access the router and what commands are used to allow access?




1.1.4.7 Lab — Configuring Basic Router Settings with CCP 33

2. What router command tells CCP to use the local database to authenticate?

3. What other show commands are available in the Utilities pane of CCP?

4. Why would you want to use CCP instead of the I0S CLI?

Router Interface Summary Table

Router Interface Summary

Router Model

Ethernet Interface #1

Ethernet Interface #2

Serial Interface #1

Serial Interface #2

1800

Fast Ethernet 0/0
(FO/0)

Fast Ethernet 0/1
(FO/M)

Serial 0/0/0 (S0/0/0)

Serial 0/0/1 (S0/0/1)

(GO/0)

(GO/1)

1900 Gigabit Ethernet 0/0 Gigabit Ethernet 0/1 Serial 0/0/0 (S0/0/0) | Serial 0/0/1 (S0/0/1)
(G0/0) (G0/1)

2801 Fast Ethernet 0/0 Fast Ethernet 0/1 Serial 0/1/0 (S0/1/0) | Serial 0/1/1 (S0/1/1)
(FO/0) (FO/1)

2811 Fast Ethernet 0/0 Fast Ethernet 0/1 Serial 0/0/0 (S0/0/0) | Serial 0/0/1 (S0/0/1)
(FO/0) (FO/1)

2900 Gigabit Ethernet 0/0 Gigabit Ethernet 0/1 Serial 0/0/0 (S0/0/0) | Serial 0/0/1 (S0/0/1)

Note: To find out how the router is configured, look at the interfaces to identify the type of router and how many
interfaces the router has. There is no way to effectively list all the combinations of configurations for each router
class. This table includes identifiers for the possible combinations of Ethernet and Serial interfaces in the device.
The table does not include any other type of interface, even though a specific router may contain one. An example
of this might be an ISDN BRI interface. The string in parenthesis is the legal abbreviation that can be used in
Cisco I0S commands to represent the interface.
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1.4.1.1 Class Activity — We Really Could Use a Map!

Objectives
Describe the three types of routes that are populated in a routing table (to include: directly-connected, static,
and dynamic).

Scenario

Use the Ashland and Richmond routing tables shown below. With the help of a classmate, draw a network
topology using the information from the tables. To assist you with this activity, follow these guidelines:

e Start with the Ashland router - use its routing table to identify ports and IP addresses/networks.
e Add the Richmond router - use its routing table to identify ports and IP addresses/networks.

e Add any other intermediary and end devices, as specified by the tables.

In addition, record answers from your group to the reflection questions provided with this activity.

Be prepared to share your work with another group or the class.

Resources

Ashland> show ip route

Codes: L - local, C - connected, S - static, R - RIP, M - mobile, B - BGP
D - EIGRP, EX - EIGRP external, O - OSPF, IA - OSPF inter area

N1 - OSPF NSSA external type 1, N2 - OSPF NSSA external type 2

El - OSPF external type 1, E2 - OSPF external type 2, E - EGP

i - IS-IS, L1 - IS-IS level-1, L2 - IS-IS level-2, ia - IS-IS inter area
* - candidate default, U - per-user static route, o - ODR

P - periodic downloaded static route

Gateway of last resort is not set

192.168.1.0/24 is variably subnetted, 2 subnets, 2 masks

C 192.168.1.0/24 is directly connected, GigabitEthernet0/1

L 192.168.1.1/32 is directly connected, GigabitEthernet0/1
192.168.2.0/24 is variably subnetted, 2 subnets, 2 masks

C 192.168.2.0/24 is directly connected, Serial0/0/0

L 192.168.2.1/32 is directly connected, Serial0/0/0

D 192.168.3.0/24 [90/2170368] wvia 192.168.4.2, 01:53:50, GigabitEthernet0/0
192.168.4.0/24 is variably subnetted, 2 subnets, 2 masks

C 192.168.4.0/24 is directly connected, GigabitEthernet0/0

L 192.168.4.1/32 is directly connected, GigabitEthernet0/0

D 192.168.5.0/24 [90/3072] via 192.168.4.2, 01:59:14, GigabitEthernet0/0
S 192.168.6.0/24 [1/0] via 192.168.2.2

Ashland>
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Richmond> show ip route

Codes: L - local, C - connected, S - static, R - RIP, M - mobile, B - BGP
D - EIGRP, EX - EIGRP external, O - OSPF, IA - OSPF inter area

N1 - OSPF NSSA external type 1, N2 - OSPF NSSA external type 2

El - OSPF external type 1, E2 - OSPF external type 2, E - EGP

i - IS-IS, Ll - IS-IS level-1, L2 - IS-IS level-2, ia - IS-IS inter area
* - candidate default, U - per-user static route, o - ODR

P - periodic downloaded static route

Gateway of last resort is not set

S 192.168.1.0/24 [1/0] wvia 192.168.3.1

D 192.168.2.0/24 [90/2170368] wvia 192.168.5.2, 01:55:09, GigabitEthernet0/1
192.168.3.0/24 is variably subnetted, 2 subnets, 2 masks

C 192.168.3.0/24 is directly connected, Serial0/0/0

L 192.168.3.2/32 is directly connected, Serial0/0/0

D 192.168.4.0/24 [90/3072] via 192.168.5.2, 01:55:09, GigabitEthernet0/1
192.168.5.0/24 is variably subnetted, 2 subnets, 2 masks

C 192.168.5.0/24 is directly connected, GigabitEthernet(0/1

L 192.168.5.1/32 is directly connected, GigabitEthernet(0/1
192.168.6.0/24 is variably subnetted, 2 subnets, 2 masks

C 192.168.6.0/24 is directly connected, GigabitEthernet0/0

L 192.168.6.1/32 is directly connected, GigabitEthernet0/0

Richmond>

Reflection

1. How many directly connected routes are listed on the Ashland router? What letter represents a direct connec-
tion to a network on a routing table?

2. Find the route to the 192.168.6.0/24 network. What kind of route is this? Was it dynamically discovered by the
Ashland router or manually configured by a network administrator on the Ashland router?

3. If you were configuring a default (static route) to any network from the Ashland router and wanted to send all
data to 192.168.2.2 (the next hop) for routing purposes, how would you write it?

4. If you were configuring a default (static route) to any network from the Ashland router and wanted to send all
data through your exit interface, how would you write it?
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5. When would you choose to use static routing, instead of letting dynamic routing take care of the routing paths
for you?

6. What is the significance of the L on the left side of the routing table?




